Microsoft Office, the Differences
Patti Greenleaf 696-5218

All Three Programs

To Save a File Down

1. On the menu bar, select File, slide down and select Save As.

2. Choose the location where you want to save the information (probably 3 1/2"
Floppy), give the file a name, then in the bottom left where it says Save As Type,
click on the down arrow and select the follow for each of the different programs:

Program Choice

Word Word 6.0/95

Excel Microsoft Excel 5.0/95 Workbook
PowerPoint PowerPoint 95

3. Once you have made the selection, click Save.

To Tell Which Version of Word A Computer Has
1. On the menu bar, select Help.
2. Slide down and select About Microsoft Word (or Excel, or PowerPoint etc.)

3. This will give you a window that tells you about the program that you are in and the
first line of text should tell which version it is.
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Inserting a WordArt Object

4
Click on the WordArt Icon on the drawing toolbar @f
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Select a WordArt Style

Enter text in the Enter Text Here dialog box then Click OK

Move the WordArt to where you want it to go

Make any other changes to the WordArt using the WordAurt toolbar that appears.

To work with the text wrapping with a WordAurt picture go to format WordArt.



Inserting Pictures (Clip Art)

In Word 97 you no longer have to insert a frame around a picture that you have inserted.
You do have to spend some time with the text-wrapping feature to have you picture work
with your graphic.

Go to Insert and click on Picture and pull to From File.

Change to the location the file is located (i.e. floppy, desktop, my documents, server, a
folder you created, etc.)

Click on the picture.

Click Insert.

Wrapping Text around the Picture

To make the text wrap around the picture, do the following:
Right Click on the picture and pull to Format Picture

Click on the Position tab and check Float over text.

Click on the Wrapping tab and select choices for the Wrapping
Style and Wrapping to the text to wrap. Click OK.

Use the Picture Tool Bar

If the Picture Toolbar is not visible, go to View and pull to Toolbars and pull to Picture
(Note: if Picture already has a check in front of it, you already have the toolbar)
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To make these work, click on the picture and then click on the tool on the toolbar.

The contrast and brightness will change the image one click at a time.

The Crop Tool lets you crop part of the image. Place the tool over one of the size boxes
and move it in the direction you want

The Line Style lets you determine what type of line you would like as a border around
your picture.

Word

To Work with AutoCorrect

This feature in Word allows you to customize options to meet your needs. For instance,
if you have a common phrase you type quite a bit or you want it to correct something for
you automatically. The difference between AutoFormat As You Type and AutoFormat is
that the AutoFormat as you type makes the formatting changes to the information that
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you are typing. The AutoFormat will make the formatting changes to material you bring
in from some place else.

To Use AutoCorrect I -]
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1. Select Tools on the Menu Bar. = et Tk sl o R, |
2. Slide down and select AutoCorrect. z‘“""“:“‘”m
3. In the AutoCorrect window make sure the AutoCorrect  —“*= ===
tab is selected. g R
4. For the first five options make sure there is a checkmark e E e
in the box if you want it selected. If you don’t want the
option click on the checkmark to get rid of it.If you _ & |
want to type a word to replace if you type it incorrectly, -
in the box under where it says Replace: type the word ] L
incorrectly (i.e. studnet). In the box under With: type ! L =
the word correctly (i.e. student). Then click the Add | |
button.
5. Click OK L ] v |

To Delete an AutoCorrect Word or Symbol

1. In the list of words, click on the entry that you want to delete to highlight it. Then
click the Delete button.
2. Click OK.

To Use Auto Text

1. Select Tools on the Menu Bar.

2. Slide down and select AutoCorrect.

3. Inthe AutoCorrect window select the AutoText tab.

4. Where it says to enter AutoText entries here, enter the phrase you would like to add
to AutoText, then click the Add button.

5. Click OK.

To Run Auto Text

1. As you type the phrase you will notice a yellow box with the phrase in it. To have the
computer finish typing the phrase for you press Enter or Tab.

To Make Changes to the AutoFormat features

Select Tools on the Menu Bar.

Slide down and select AutoCorrect.

In the AutoCorrect window select the appropriate tab.

Make the desired changes AutoFormat features. You will probably want to make the
changes in both windows.
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Hyperlinks in Microsoft Word 97

1. On the menu bar, select Tools, slide down and select AutoCorrect.
2. Select the AutoFormat As You Type tab, and in the section “Replace As You
Type”, uncheck the box next to Internet and network paths with hyperlinks.
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3. You must also select the AutoFormat tab, and in the section “Replace”, uncheck the
box next to Internet and network paths with hyperlinks.
4. Click OK.

Grammar Checker

The grammar checker has been improved in the 97 version of Word. As you type the
program places a green squiggly underline for any grammar mistakes it finds. If you do a
right mouse click on the green squiggly line you will get a list that shows you what Word
believes is wrong with the statement. If you like their choice click on the desired change
to make the correction.

Mail Merge Printing

It came to our attention recently by a user in the district that the mail merge feature in
Word 97 does not print selected pages the same way mail merge does in Word 95. If you
are printing the whole job or the current page it is the same. However, if you only want to
print only certain pages the process is a little different.

1. On the menu bar go to File, slide down and select Print.

2. Inthe Print window, click the radio button for Pages under Page Range. Then in the
box next to Pages type an S before the page numbers you want to print. For instance,
if you want to print pages 1, 4, and 7, in the box you would type s1, s4, s7.

Creating a Template

From Scratch, New Document

1. On the Menu Bar, click on File, select New

2. On the New Dialog box at the bottom right, select Create New Template (notice in

the title bar it usually says Document 1 but now it says Template 1)

Type the document the way you want it to appear.

4. When you save it notice that it automatically wants to save it as a Document
Template. (You can’t save it as a different file type) It also wants to save it in the
Templates folder; this is so that when you click File, New you can open the template
file. Give the file a name and leave it in the template folder.
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After You Have Created a Document

1. If you have typed a document and have decided that it would be a good template, you

can save the file as a document template.

On the Menu Bar, click on File, select Save As.

3. Inthe Save As window in the bottom left where it says Save As Type change that to
say Document Template. You will notice that it automatically changes the location of
where it is going to save to the Template folder. Give the file a name and leave it in
the template folder.
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To Run a Template (that has been saved in the Template folder)

1. On the Menu Bar, click on File, select New.
2. Inthe list of file icons double click the template you want to open.



3. You will notice that on the top it will say Document 1 so that if you make changes it
is not affecting your template.

To Make changes to your Template

=

On the Menu Bar, click on File, select Open.

2. In the Open window where it says Look in navigate to the Templates folder. (Go to
the C drive, double click on the Program Files folder, double click on the Microsoft
Office folder, double click on the Templates folder.)

3. Also in the Open window on the bottom left where it says Files of Type, select
Document Templates.

4. This will allow you to see your template files, double click on the file you want to
change.

5. Notice up in the title bar it says the name of the template not Document 1 so you are
actually making changes to the template file.

6. When done making changes save it.

Creating Documents/Templates with Form Fields

1. You usually want to create a Form as a template so follow the steps to create a
template. (On the Menu Bar, click on File, select New. On the New Dialog box at
the bottom right, select Create New Template.

2. To insert form fields you must turn on the Forms toolbar. On the Menu Bar, select
View, slide down to Toolbars, slide over and select Forms.

3. When you are ready to insert a form field, click the appropriate icon from the form

field menu.
Checkbox
Text Form Form Field J Protect
Field Form
Drop
Down
4. To add options to the drop down field double click on the field once you have

selected it from the Forms toolbar.

Continue this process until you have entered all the desired fields and text for your
form.

Before you save it you need to protect it so that people can only type in the form field
area. Select the Protect Form icon on the Forms toolbar.

7. Save the document/template.
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To Make changes to a Form Field Document/Template

1. Open the document/template.
2. Unprotect the file. On the Forms toolbar, select Protect Form icon.
3. Make changes; remember to protect the document again before you save it.



Working with Tables

In Word 97 you can draw your table and cells using a pencil-like mouse point. The
biggest advantage of this is to able to place a table exactly where you want it.

To Draw Your Own Table

1. Click on Table on the Menu Bar and slide down and select Draw Table. Or click

the Draw Table icon on the Standard Toolbar.

Draw your table and enter the information.

3. Your can make necessary formatting changes in the Table menu or on the Table and
Borders Toolbar which will appear when you draw your table.
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Other New Features of the Table

In the Table menu or on the Tables and Borders Toolbar you can distribute your rows or
columns evenly. Making which every rows or columns you highlight equal length.

In the Tables and Borders Toolbar, you can align text vertically in a cell.

Where Has the Thesaurus Gone

The Thesaurus is now in the Language submenu of the Tools Menu. On the Menu Bar,
click on Tools, slide down and select Language. The keystroke combination for

Thesaurus is still Shift+F7.

Excel

Creating Notes (Comments)
The Notes command found in the Insert Menu is now called Comment

To Insert a Comment

On the Menu Bar, click on Insert, slide down and select comment.
In the box provided type your comment.

To Edit or Delete a Comment

Place your mouse on top of the cell that has the comment and right mouse click.
On the menu that appears, select to either edit or delete comment.
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Entering a Formula

1. Click on the cell where you want to~enter a formula
2. Type an equal sign (=) or click on the egual sign on the formula bar
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Type the formula that you want to use
Press Enter or Click the ¢ button next to the formula bar
Excel enters the formula in the active cell and displays the resulting value. The

formula will still show up in the formula bar so that you can see both the formula and

the result simultaneously.

Using the Function Wizard
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If you'd like to paste a function into a particular cell,
Click on the cell that you want to paste a function into,
Click the Function Wizard (Fx) button next to the formula bar ,

Scroll through the choices and find the function you want and click on it, Click OK.
Then type the cell cqordinates that should be included, use a colon between cell

coordinates, type in any other needed information and press OK. For example
=Average(A2:A8) would calculate the average for values in cells A2 through A8.
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This window is also new in Excel
L-97 and usually is in the way
because it is covering up your
information. You can click on it
with your mouse and drag it out
of the way.
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Range Finders

You can also click on this icon to
get back to your worksheet to
select the area for your function.
To get back to this window click

the icon again.

If you click on the formula or function in the Formula Bar you will notice that the
formula becomes colored and is associated with the colored ranges in the worksheet.

Centering Headings across Columns

1. Enter your data into a cell in column A
2. Select the cell containing your data and drag through the cell range you want your

heading centered across

3. Click on the Merge and Center icon on the toolbar

Once you have done this it makes the whole area you highlighted your A cell (or

whatever cell you started with).

Creating A Chart

Most charts include a title, a legend to help clarify what each data series represents, a y-
axis, and an x-axis. Typically, values are plotted along the vertical plane (y-axis) and
categories are plotted along the horizontal plane (x-axis).

To create a chart

Select the data you want included in the chart from an existing worksheet
Click the Chart Wizard icon from the toolbar




A dialog wizard box will appear

Step 1

Click on the Chart type you would like to use
Click on the Next button to move to Step 2

In the Data Range tab check to make sure the selected range is correct (the $ in front
of each column letter and row number indicates that these are absolute references). A
series can be either the information in rows or columns, switch between the two to see
how it changes your chart preview.

In the Series tab you can choose to add or delete a series. The name box shows which
information will be in the legend for a series. The values show which values will be
displayed for a series.

Click the Next button to move to Step 3
In this step you can make sure your charted data looks the way you want it (make
changes as needed)

Titles tab—enter the information you would like for your titles.

Axis tab—you can decide to view axis titles or not.

Gridlines tab—Add or delete horizontal and vertical gridlines.

Legend tab—you can decide to whether to show the legend or not and the location of
it.

Data Labels tab—this is where you can give each piece of data a label.

Data Table tab—you can select to have a table of the information placed with your
chart.

Click on the Next button to move to Step 4
Decide if you want the chart to be on the same sheet as the data or on a separate sheet
Click Finish.

Page Break Preview

This command allows you to see how your sheet will print.

1.
2.

On the Menu Bar, select View. Slide down and select Page Break Preview.
You then can adjust the blue lines that show your page breaks by clicking on them
and moving the lines. Depending on how you adjust these lines, it will change the
size of your text when it is printed.

To get back to the normal view, on the Menu Bar, select View. Slide down and
select Normal.

Conditional Formatting

Applies formatting automatically to a cell if its value meets criteria you specify.

1.
2.
3.

Highlight the cells you want to have the conditional formatting.
On the Menu Bar, select Format. Slide down and select Conditional Formatting.
Entry criteria.

Working with Borders

In Excel 95, if you wanted to have a border at the bottom of a row all you had to do was
highlight the information and then select the bottom border on the borders icon. This
would in essence underline each row that was highlighted.



1. In Excel 97, you must highlight the cells where you want the border and then on the

Menu Bar, select Format, and slide down and select Cells.

Click on the Borders tab.

3. On the left side of the window, click on the borders you want. For the one the bottom
of each cell you must also select the middle border.
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PowerPoint

Inserting a Custom Background to a Presentation

1. In the slide view, click on Format on the Menu Bar, and slide down to and select
Background.

Click on the down arrow in the middle of the window, and Fill Effects.

Click on the Picture Tab.

Click on Select Picture.

Navigate to the folder with the picture file.

Double click on the desired picture file.

Click OK.

Back in the Background window, select Apply (to apply to one slide) or select Apply
to All (to apply to all slides in the presentation).
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Animation Settings (Renamed Custom Animation Settings)

Allow you to change the order of your animations, timings, the effects, chart effects or
the play settings.

Select Slide Show from the Menu bar, slide down and select custom animation. Click
on the various tabs to make your changes.

Interactive Settings (Renamed Action Settings)
Interactive settings let you build interactions into your slides that will take you to other
slides or allow you to run a program by clicking on the icon (text) during a presentation.

Branching to Another Slide or Embedded Program

Allows you to create branches in your presentation to another slide or another embedded
presentation (maybe has different slide orientation). When you branch to a presentation
you automatically return to the original presentation; when you branch within a
presentation you can you Slide Navigator or create another button to return to the first
slide.

Set up a branch to another slide or Web Page

1. Go to Slide Show and pull to Action buttons. Sk Show Yndow Help
2. Select the butto
3. Draw the shape of the n on your slide, whe
let go of the button, the Action Settings window will
appear.
4. Select Hyperlink To, then select the slide you want to

branch to on the drop down list: you can also select QI;J i ﬂ
another PowerPoint Presentation or URL (type the entire || ) | =)
address http://www.amphi.com). Ak Prg e '

B e sdde
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5. Click OK.

To return to the first slide create a button on the branch slide that returns you to the first
slide.

Set up a branch to a Program

You can also branch to another program like Word or a specific page on the Internet to

use while in your presentation. T
Shcle Shosr Window  Heip
1. Go to Slide Show and pull to Action buttons. gwm
Betearas Tnings:
2. Select the button. P
3. Draw the shape of the button on you o of Sak Lip Show..

the button, the Action Settings window will appear:
4. Select Run Program, then click on Browse.
5. Navigate to Find the program. Double Click on the program.
6. Click OK.
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Recoloring Clip Art

Click on the Recolor Clipart icon on the
Make your changes in this window.

Inserting Sound Clips to a Presentation

1. Go to the Insert Menu Bar.

2. Click on Movies and Sounds and pull to Sound from File

3. Inthe Insert Sound window, navigate to the folder with the sound clip.
4. Double click on the desired sound clip file.

Inserting Movie Clips to a Presentation

1. Go to the Insert Menu Bar.

2. Click on Movies and Sounds and pull to Movie from File

3. Inthe Insert Movie window, navigate to the folder with the movie clip.

4. Double click on the desired movie file.

If you can’t see the movie files in the folder type in *.mpg (or the extension of the movie,
it might be *.avi also) where it asks for the filename.
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Inserting a Custom Background to a Presentation

1. In the slide view, click on Format on the Menu Bar, and slide down to and select
Background.

Click on the down arrow in the middle of the window, and Fill Effects.

Click on the Picture Tab.

Click on Select Picture.

Navigate to the folder with the picture file.

Double click on the desired picture file.

Click OK.

Back in the Background window, select Apply (to apply to one slide) or select Apply
to All (to apply to all slides in the presentation).

NG WN

Bring an Object Forward, Back, etc.

This option has moved to the Drawing Toolbar.
Click on Draw, and slide to and selegt Order.
Make yout selection.
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Slide Show Menu
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The Slide Show menu is new in PowerPoint 97. It contains many commands that were
on the Tools menu in PowerPoint 95.

This PowerPoint 97 Command Allows you to

View Show Launch your slide show in full screen view.

Rehearse Timings Capture timings as you rehearse a
presentation.

Record Narration Make an audio recording to narrate the
slide show.

Set Up Show Define the type of show, a range of slides,
advance method, and pen color.

View On Two Screens Show a presentation from one computer on
another through a serial connection.

Action Buttons Place a button with interactive settings on a
slide.

Action Settings Define an action for the object, such as

playing a sound when the object is clicked
during a slide show.

Preset Animation Apply animation effects to the selected
object.

Custom Animation Define animation, sound effects, and
timing for objects on a slide.

Animation Preview View the current slide in miniature,
including all animation associated with the
slide.

Slide Transition Define special effects for progressing from

one slide to the next in a slide show. This
command was moved from the Tools
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menu.
Hide Slide Skip a selected slide during a slide show.
This command was moved from the Tools
menu.
Custom Shows Create sections within presentations,
making it easier to tailor presentations for
specific audiences.
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